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1	�  
Introduction

1.1	 Description

The GloMax® Galaxy Bioluminescence Imager is a luminescence microscope that can visualize 
the output from NanoLuc® Technologies. The combination of this imager and NanoLuc® 
Technology means you can study functional and dynamic cellular events across a population 
of cultured cells. These events include protein localization, protein:protein and protein:small 
molecule interactions, as well as changes in protein abundance via degradation or stabilization. 
With the GloMax® Galaxy Imager, NanoLuc®-based microplate reader assays (e.g., NanoBiT, 
NanoBRET or Nano-Glo) can be complemented with luminescence, fluorescence and 
brightfield microscopy to study and validate cellular model systems prior to and post-
screening.

The system is operated by a personal computer (PC) and control software that provide quick 
and easy navigation through the control options.

Figure 1. The GloMax® Galaxy Bioluminescence Imager.
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1.2	 Specifications

Instrument Specifications

Imaging Modes Luminescence, Filtered Luminescence, Fluorescence, 
Brightfield 

Sample Format Slide, microchamber, 35mm dish, 6-, 12-, 24-, and 96-
well plates

Dimensions (W × H × D) 14.8 inches × 18.8 inches × 21.0 inches  
(37.3cm × 47.7cm × 53.3cm)

Weight Approximately 62lb (25kg)

Power Requirements 100–240V AC, 50/60Hz

Warranty 1 year parts and labor warranty included

Regulatory Compliance For Research Use Only. Not for use in Diagnostic 
Procedures.

CE Compliance Pollution degree 2

Installation category II

Indoor use only

Main supply voltage fluctuations are not to exceed 
±10 percent of the nominal supply voltage

This instrument complies with the requirements of the 
EU Directives for electromagnetic compatibility (EMC 
Directive) and electrical safety (the LVD). Compliance 
with the relevant Directives was demonstrated by third-
party testing to the appropriate EN and IEC standards. 
The product bears the CE mark on its label as evidence 
of compliance, and an EU Declaration of Conformity for 
the product is available from Promega on request.

Camera Retiga E7 (CMOS), 4.5 × 4.5µm pixel size, 12-bit  
(0–4,095 gray scale)

Wavelength Range 400–750nm

Optics Nikon CFI Plan Apochromat Lambda D 20X/0.75 NA

Custom 100mm focal length Tube Lens  
(~10.35X System Magnification)

Image pixel size 1 pixel = 0.435µm
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Fluorescence Excitation Specifications:

Light Source LED

Excitation Position Top (trans-) illumination 

Wavelength Selection Interchangeable on-the-fly, with five excitation modules 

Excitation Module Included Blue (Excitation: 480/30nm)

Excitation Modules Available 
Separately

UV (Excitation: 375/20nm)

Green (Excitation: 540/25nm)

Green (Excitation: 560/40nm)

Amber (Excitation: 620/60nm)

Emission Filters Included 460nm/50BP (band pass), 535nm/40BP,  
600nm LP (long pass)

Available Separately 635nm/60BP; 605nm/55BP; 700nm/75BP

Filter Slide Four position for up to four standard (25mm) filters

Computer Requirements

Operating System Windows® 10, 64-bit version 

RAM 16GB minimum

Disk Space 512GB minimum

Ports Two (2) USB 3.2 connections for system 
communication and optional stage top incubator 
communication

Other Requirements Microsoft.NET Framework 4.8 or newer (full version)

Monitor The minimum recommended screen resolution 
is 2560 × 1440. The recommended screen size is 
27 inches.

Additional Computer Recommendations if Using Your Own PC:

•	 Disable automatic Windows® updates and virus scans

•	 Disable automatic power off, sleep or hibernation settings

	 Disable “Fast Startup”. Set the power button to Shut Down, not Sleep.

	 Disable any other automatically or manually started software that would consume PC 
resources during operation.

•	 Ensure there are no domain policies that would overwrite any of the above settings.
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1.3	 Product Components

P R O D U C T  	  S I Z E  	 C AT. #

GloMax® Galaxy Bioluminescence Imager System 	 1 each 	 GM4000

Includes:

•	 1 	 GloMax® Galaxy Bioluminescence Imager

•	 1 	 PC preloaded with GloMax® Galaxy Control Software and Fiji Image Processing Software

•	 1	 PC Monitor (27 inches)

•	 1	 Power Cord for PC

•	 1	 Power Cord for PC Monitor

•	 1	 Keyboard for PC

•	 1	 Mouse for PC

•	 1 	 Blue Fluorescent Excitation Module (Ex: 480nm/30BP)

•	 1 	 �Filter Slide containing filters (1 each) 460nm/50BP, 535nm/40BP and 600nm LP filter

•	 1 	 1-Position Slide Holder Insert

•	 1 	 AC Power Adapter with detachable power cord

•	 1 	 USB 3.1 Cable

•	 1 	 Flat-Tip Screwdriver

•	 1 	 Spare XY-Stage Adapter screws

•	 1 	 Side Access Panel with Rubber Insert

•	 1 	 Shipping anchors and thumbscrews set

•	 1	 Hex wrench for side access panel with extra screws

•	 1	 Air bulb
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P R O D U C T  	  S I Z E  	 C AT. #

GloMax® Galaxy Bioluminescence Imager	 1 each 	 GM4005

Includes:

•	 1	 GloMax® Galaxy Bioluminescence Imager

•	 1	 Blue 480/30nm Fluorescence Module, Galaxy

•	 1	 �Filter Slide containing emission filters (1 each) 460nm/50BP, 535nm/40BP and 600nm 
LP filter

•	 1	 1-Position Slide Holder Insert

•	 1	 AC Power Adapter with detachable power cord

•	 1	 USB 3.1 Cable

•	 1	 Flat-Tip Screwdriver

•	 1	 Side Access Panel with Rubber Insert

•	 1	 Spare XY-Stage Adapter screws

•	 1	 Shipping anchors and thumbscrews set

•	 1	 Hex wrench for side access panel with extra screws

•	 1	 Air bulb
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1.4	 Precautions and Special Instructions

1.4.1	 Safety Symbols and Special Markings

5295MA.eps

Warning. Risk of personal injury 
to the operator or a safety hazard 
to the equipment or surrounding 
area.

Avertissement. Risque de 
préjudice corporel pour  
l’utilisateur ou risque de danger 
pour l’appareil ou la zone 
environnante.

6687TA.eps

It is important to understand and 
follow all laws regarding the safe 
and proper disposal of electrical 
instrumentation. Please contact 
your local Promega Representative 
for disposal of the instrument 
and power supply. Please follow 
your institutional requirements for 
disposal of the accessories.

Avertissement. Il est important 
de comprendre et de respecter 
toutes les lois relatives à la 
destruction sure et correcte des 
appareils électriques. Veuillez 
contacter votre représentant 
Promega local concernant la 
destruction de l’appareil.Veuillez 
respecter les exigences de votre 
établissement concernant la 
destruction des accessoires.

Warning. UV emitted from this 
Product. Avoid eye and skin 
exposure to unshielded product.

Avertissement. UV émis par cet 
appareil. Evitez toute exposition 
des yeux et de la peau avec cet 
appareil ouvert /non protégé. 

13
63

1T
A

Clean up spills. Nettoyer toutes éclaboussures.

11
60

3T
A
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1.4.2	 Special Instructions
•	 Immediately wipe up spills.

•	 The GloMax® Galaxy Imager contains sensitive optical components and precision-aligned 
assemblies. Handle with care.

•	 The objective lens is an air (dry) objective and should never be used with immersion oil.  If 
this happens, lens cleaning paper soaked in petroleum benzine is recommended for 
cleaning off the oil, followed by ethanol. See Section 4.2.1, Cleaning Instructions.

•	 Use caution around solvents because they may damage the plastic case of the GloMax® 
Galaxy Imager.

•	 Do not submerge the GloMax® Galaxy Imager in water.

•	 Do not expose the GloMax® Galaxy Imager to temperatures outside the specified range, as 
damage may occur to the unit that will not be covered under warranty.

•	 Changes or modifications to this unit not expressly approved by Promega could void the 
user’s authority to operate the equipment.

•	 Do not use this device in proximity to sources of strong electromagnetic radiation (e.g., 
microwave oven) because they may interfere with the proper operation.

•	 Do not use this instrument for anything other than its intended use.

•	 Always disconnect the power before cleaning or performing routine maintenance.

•	 Do not disassemble the instrument further than specified in this operating manual for 
routine maintenance and use.

•	 If the equipment is used in a manner other than that specified, the protection provided by 
the equipment may be impaired.

•	 Do not overfill sample vessel wells because this may lead to spills and/or damage.

•	 Plug instrument and PC into the same wall socket or outlet strip to assure common 
grounding.

•	 Do not leave sample vessel in the instrument after imaging is completed.
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1.4.3	 Important Safety Instructions—Please save these instructions.

5294MA.eps

Power off the GloMax® 
Galaxy instrument before 
installing.

Éteignez l’instrument 
GloMax® Galaxy avant 
l’installation.

5295MA.eps

Close the instrument door 
when the GloMax® Galaxy is 
not in use.

Fermez la porte de 
l’instrument lorsque le 
GloMax® Galaxy n’est pas 
utilisé.

5295MA.eps

The GloMax® Galaxy is 
intended for indoor use only.

Le GloMax® Galaxy est 
destiné à une utilisation en 
intérieur uniquement.

5295MA.eps

Always disconnect the power 
before cleaning or performing 
routine maintenance.

Débranchez toujours 
l’alimentation avant de 
nettoyer ou d’effectuer un 
entretien de routine.

5295MA.eps

Always disconnect the AC 
Adapter from the power 
outlet when not in use.

Débranchez toujours 
l’adaptateur secteur de la 
prise de courant lorsqu’il n’est 
pas utilisé.

1.5	 Environmental Requirements

Store and use the GloMax® Galaxy Imager under the following conditions:

Shipping and Storage Conditions 4–50°C, under noncondensing conditions, up 
to 80% humidity

Operating Conditions +15°C to +30°C, 20–80% humidity

Operating Altitude Conditions 0 to 2,000 meters above sea level
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1.6	 Unpacking and Inspecting the GloMax® Galaxy Bioluminescence 
Imager

Upon receiving the GloMax® Galaxy Imager, inspect it carefully and make certain all 
accessories are included. 

Refer to the checklist shipped with the instrument for order-specific items. Save all packaging 
materials, if possible, in case the instrument needs to be returned for service. If any item is 
damaged, contact Promega Technical Services (email: techserv@promega.com).

1.6.1	 Unpacking the Instrument from the Shipping Container
1.	 Remove the straps around the boxes and pallet. Open the solid box containing the PC and 

monitor and remove them from the box (Figure 2, Panel A). 

2.	 Next, remove the outer sleeve of the bottom box containing the instrument and remove the 
accessory box and foam insert (Figure 2, Panel B). Carefully lift the box top to expose the 
instrument which rests on the foam tray.

Figure 2. 
19

23
2T

A

B.A.

Panel A. GloMax® Galaxy shipping pallet. Panel B. Foam packaging for the imager.
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1.6.2	 Unpacking the White Instrument Accessory Box
Figure 3 shows the GloMax® Galaxy Imager accessories that should be present in the 
accessory box. 

Figure 3. 

19
16

4T
A

Power cord for imager Excitation module Flat-tip screwdriver
1-Position Slide 

Holder Insert

AC power adapter USB cable
Side access panel 
with rubber insert

Hex wrench with 
extra screws 

Air bulb

Container with extra
stage adapter screws 

GloMax® Galaxy Imager accessory components. Components shown include: Power cord for imager, Blue 
Fluorescence Excitation Module, flat-tip screwdriver, air bulb, 1-Position Slide Holder Insert, AC power adapter, USB 
cable, hex wrench with extra screws, container with spare stage adapter screws, and side access panel with rubber 
insert (when used with the Stagetop Chamber/Controller accessory). The 1-Position Slide Holder Insert and 
Fluorescence Filter Slide and Filters are preinstalled on the instrument.
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1.6.3	 Removing Instrument Packing Brackets
1.	 Place the GloMax® Galaxy Imager on a flat, level surface. 

Note: We recommend that two people lift the instrument into position.

2.	 Ensure that the instrument is placed in a location that meets the power requirement 
specifications (100–240V AC, 50/60Hz; Section 1.2).

3.	 Manually open the top lid of the instrument; remove the foam form from the LED module 
arm, remove the red thumbscrews of the red stage shipping brackets (Figure 4). Store 
these in your GloMax® Galaxy Bioluminescence Imager accessory box in case they are 
needed later to ship the unit for service. 

Figure 4. 

19
16

5T
A

B.A.

Shipping brackets.  
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2	� Setting Up the GloMax® Galaxy  
Bioluminescence Imager

2.1	 Setting Up the GloMax® Galaxy Bioluminescence Imager and PC

2.1.1	 PC Purchased with the GloMax® Galaxy Imager
1.	 Unpack the PC and Monitor from their shipping boxes.

2.	 Place the PC and Monitor next to the GloMax® Galaxy Imager.

3.	 Attach the provided PC Power Cord to the back of the computer and to a power outlet.

4.	 Attach the provided Monitor Power cord to the back of the monitor and to a power outlet.

5.	 Using the provided monitor to PC cable, connect the monitor to the PC.

6.	 Using the provided USB cable, connect the PC to the USB port (Type B) on the back of the 
instrument as shown in Figure 5. 

Figure 5. 
19

16
7T

A

B.A.

Power connection

USB and HDMI
 connections USB Cable

AC Power
Adapter

Panel A. Back of the PC. Panel B. Back of the GloMax® Galaxy Imager.

7.	 Ensure that the instrument On/Off switch is in the off position.

8.	 Connect the Instrument AC Power Adapter to the back of the instrument and to a power 
outlet.

	 Note: We recommend connecting the instrument to an uninterrupted power supply 
(~500VA).
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2.1.2	 User-Provided PC
1.	 Refer to Section 1.2 for PC and monitor specifications.

2.	 GloMax® Galaxy Control Software can be downloaded from:  
www.promega.com/resources/software-firmware/

3.	 Copy the software installation package to the target PC and launch the installer.

4.	 Follow the on-screen instructions to install the GloMax® Galaxy Control Software.

	 Note: The installer includes Fiji (ImageJ) as an optional application (see Section 8). If 
desired, check the box to “Install Fiji” on your PC.

5.	 Using the provided USB cable, connect the PC to the USB port on the back of the 
instrument (see Figure 5).

2.2	 Switching On the GloMax® Galaxy Bioluminescence Imager

1.	 Switch on the instrument power button on the rear panel of the instrument. Make sure the 
external power supply On/Off switch is turned on. Ensure the shipping brackets have been 
removed (see Figure 4, Panel A).

2.	 Press the power button, left front corner of the instrument, to power on the instrument. An 
LED in the power button on the front of the instrument will turn yellow, indicating that the 
instrument is on.

3.	 Power up the PC by selecting and holding the power button on the front. 

4.	 Power up the monitor by selecting the power button at the front lower right corner.

5.	 Launch the GloMax® Galaxy Control Software from the Start menu or desktop shortcut. 
The control software will begin its start-up protocol. After the operating software starts, it 
will check for a connected and powered instrument and begin the initialization process. A 
green indicator at the lower right of the control software window will indicate successful 
connection and initialization (Figure 6), and the LED in the power button on the front of the 
GloMax® Galaxy Imager will turn green.

6.	 The GloMax® Galaxy Imager is now ready to use.
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Figure 6. 

19
16

6T
A

GloMax® Galaxy software ‘Home’ screen.

2.3	 Shutting Down the GloMax® Galaxy Bioluminescence Imager

1.	 Switch off the instrument by holding the power button on the left front corner of the 
instrument until the LED turns off or by using the On/Off switch on the back of the 
instrument.

	 Note: When the instrument is not in use for a prolonged period, turn off the external power 
supply using its own On/Off switch. 

2.	 If the GloMax® Galaxy Imager is powered off while connected to the Control Software, or 
the instrument fails to connect and initialize, the indicator at the lower right corner of the 
Control Software window will be yellow and indicate that the instrument is not connected. 
You will see one of two different pop-up messages: “Instrument not connected. Reconnect 
and try again.” or “Instrument Disconnected”.

3.	 Close the GloMax® Galaxy software by selecting the X in the upper right corner (Figure 6).

4.	 Shut down the PC using the Start button to open the Start menu, select the Power icon on 
the left side of the Start menu. From the Power drop-down list, select Shut down.

	 Note: When not in use for a prolonged period, the system should be powered off. 
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2.4	 Operating the GloMax® Galaxy Bioluminescence Imager

1.	 Start a new imaging session by selecting the Capture button on the ‘Home’ screen (Figure 6). 

2.	 The XY-Stage will move to the front of the instrument for access to install the stage 
adapter and sample vessel.

3.	 The ‘New Session’ window will open (Figure 7).

Figure 7. 

19
16

8T
A

‘New Session’ window.

•	 Customize the Session ID, if desired.

•	 Select the Vessel type from the drop-down list. 

	 Note: Individual focus offsets that specify the distance of the sample from the 
objective have been defined for recommended imaging labware to aid in initial 
focusing. Ensure that the vessel type and manufacturer and part number chosen from 
the drop-down list corresponds to that in which the sample was prepared. If a new 
vessel needs to be defined, follow instructions in Section 3.10 for setting a new vessel 
type definition and corresponding focus distance. 

•	 Supply a text Tag, if desired. Later, the Tag entered can be used to filter the saved 
Sessions list to more quickly find the desired Session(s).

•	 Choose your sample type, either Fixed Cells or Live Cells. This selection determines the 
fine- and extra-fine focus controls, which are user editable. (See the ‘Calibration’ tab 
under Preferences in Section 3.9.)

•	 Check “Use incubator” if the Stagetop Incubator/Controller, GloMax® Galaxy, is 
installed. (See setup and use instructions at: www.promega.com/products/imaging-
devices/glomax-galaxy-bioluminescence-imager/)

•	 Open the Instrument lid, install the appropriate adapter on the stage, load your sample 
vessel onto the stage, and close the instrument lid. 

	 Important: Make sure the proper adapter is mounted on the stage before starting a 
new session! Navigating the stage to the default start position for the selected vessel 
type can damage the objective if the wrong adapter is installed.

5295MA.eps
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•	 Select Start. The ‘Imaging’ Screen will open (Figure 8).

Figure 8. 

19
16

9T
A

‘Imaging’ screen for a new session.

4.	 The XY-stage will move to the default starting position for the selected vessel type (well A1 
of a multiwell plate or center of 35mm dish and slide). The position will be indicated by a 
dotted cross on the vessel diagram of the ‘Imaging’ screen (Figure 9). 

Figure 9. 

19
17

0T
A

Vessel diagram for the 8-well microchamber slide. Selecting a well position will move the stage to its 
center. Clicking again within the same well will move the stage to that position within the well. Right-click to create or 
move to bookmarked positions.
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5.	 The objective will move to the default starting position for the selected vessel type. This 
should be near the focal plane for the recommended vessel. You can create duplicate 
vessels and adjust the focus distance for imaging in vessels from other manufacturers 
(see Section 3.11.4, Vessel Default Imaging Position). 

6.	 Select the yellow + in the left panel of the screen to add a capture channel. A new 
Luminescence, Fluorescence or Brightfield channel may be created, or an existing protocol 
may be selected (Figure 10). 

Figure 10. 

19
17

1T
A

Adding a capture channel. 
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7.	 Select the Start button to start image acquisition and display a live-view image. The 
live-view image will be generated using the settings of the selected (highlighted in blue) 
capture channel (Figure 11).

Figure 11. 

19
17

9T
A

Selected capture channel. 
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8.	 Focus using the coarse, fine and extra-fine up and down arrow buttons (hover over these 
buttons to see the keyboard shortcuts). Select the vessel diagram (upper right in Figure 10)  
or use navigation buttons (Figure 12) to move the XY-stage to change the field of view.  
The         button returns the objective to the default starting focal position for a new 
imaging session.

9.	 When starting a new imaging session, we suggest establishing the initial focus of the 
sample using brightfield mode. Focus can then be fine-tuned in either fluorescence or 
luminescence imaging modes. Use of digital zoom (Section 2.4) can aid in making fine 
focus adjustments.

Figure 12. 

19
17

2T
A

X (left-right)
controls

Y (up-down)
controls

Focus
controls

Fine

Fine
Extra fine
Return to default focus

Coarse

Coarse

Navigation buttons.

10.	 A digital zoom feature (Figure 13) enables the user to zoom in on as little 1/10 of the full 
field of view to see sample detail. The portion of the field of view on screen is highlighted 
by the yellow box in the live-view thumbnail at the lower right of the ‘Imaging’ screen. The 
zoomed region will default to the center of the field of view as the slider is adjusted but 
may then be dragged to any portion of the image thumbnail. Captures and Time Series 
initiated with digital zoom active will save a full-field image.
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Figure 13. 

19
17

3T
A

Digital zoom and live-view thumbnail. 

11.	 Use the Capture and Time-Series buttons to initiate image acquisition. 

12.	 To view images captured during an imaging session, select the ‘Review’ tab at the upper 
left of the session window. Captures will be listed on the left panel in the order acquired. 
The selected capture (highlighted in blue) will be displayed on screen, with the capture 
channels listed on the right panel. Individual channels may be selected or deselected and 
adjusted individually. (See ‘Review’ tab, Section 3.7.)
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2.5	 Dark Frames

The background signal within luminescence images is composed primarily of camera noise 
but may also have contributions from light leaks or sources such as phosphorescence from 
the sample vessel. We suggest capturing images of this background signal to be used in 
downstream analysis (see Section 8.1). Such images may be referred to “dark frames”. 

Dark frames should be captured using the same capture channel settings used for their 
associated luminescence images. Commonly, dark frames are captured after removing the 
luminescence sample vessel from the stage, but in some cases, capturing dark frames from 
a control vessel or well that does not contain luminescence may better match the sample 
imaging context. If multiple replicate dark frames are captured, they may be stacked, averaged 
and then subtracted from sample images to remove hot pixels, dead pixels and any noise 
patterns inherent to the camera sensor.

Note: The GloMax® Galaxy stage is designed to be light impenetrable. Average dark frame 
signal is typically less than 101 gray units and remains consistent with increasing exposure 
time. If excessive signal is noted in dark frames, check that the instrument lid is closing tightly 
and that the lid foam gasket is not damaged. Check the fit and tightness of 2 × 3 inch side 
panels, the two small panels that cover the side-access ports. If using the Stagetop Incubator/
Controller, check that the tubing fits in gasket slots and the side panel is securely attached 
to the instrument. If increased signal is noted in dark frames as exposure time is increased, 
there may be a light leak or source of phosphorescence. Phosphorescence occurs when a 
material becomes “charged” from light exposure and then slowly releases that light energy. For 
example, some white-walled plates used for luminescence assays are prone to phosphoresce.
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3	�  
GloMax® Galaxy Control Software

3.1	 ‘Home’ Screen 

The ‘Home’ screen (Figure 14) is the main beginning point for interaction with the 
functionalities built into the GloMax® Galaxy Control Software. 

Figure 14. 
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GloMax® Galaxy software ‘Home’ screen.
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The four ‘Home’ screen buttons are:

Capture Initiates a new imaging session to view and image your samples, 
add capture channels, save protocols and initiate Captures and Time 
Series. To start a new imaging session, select the vessel type (slide, 
microchamber, 35mm dish, 6-, 12-, 24-, or 96-well plate), sample type 
(Live Cells or Fixed Cells) and indicate whether a stage-top incubator is 
installed or not.

Gallery Displays a list or table of saved imaging sessions that may be opened 
and reviewed. List items can be filtered by start and end date, or use 
a keyword search to find results based on session name or other 
associated information.

Protocols Lists all available pre-installed and user-saved protocols. When a 
protocol is selected, users can view details and use a shortcut from the 
protocol details panel to initiate a new imaging session (the Capture 
button).

Settings Lists instrument information and setup options. You can access 
Navigation and Camera settings, specify where files are saved on the 
PC, export log files and view system information.

3.1.1	 Home Screen Features
The ‘Home’ screen and all others contain basic Windows® functions for minimize, maximize 
and close at upper right corner of the control application window (Figure 15).

Figure 15. 
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Windows® close, maximize and minimize buttons on the GloMax® Galaxy Control Software window 
inside the blue box. 
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The connected Instrument name appears in the title bar of the control application. The 
following buttons are also displayed within the title bar:

Home From any screen other than the ‘Home’ screen, select this icon to 
return to the ‘Home’ screen.

 
Exit

Closes the GloMax® Galaxy software.

 
Back When active, selecting the Back button will return the interface to the 

screen accessed prior to the current screen.

 
Excitation 
Modules

Displays the installed excitation module (Figure 15).

 

Emission 
Filter

Displays the current emission filter configuration (Figure 19) and 
moves the filter slide to a safe position for removal to change 
emission filters. Up to four filters can be installed on the GloMax® 
Galaxy Imager. Filters are manually assigned in the software by 
selecting the filter at each position from a drop-down list. Filters may 
be added to the drop-down list using the ‘Custom Filters’ tab. The 
excitation filter slide accepts standard 25mm filters, no more than 
5mm thick, installed in an Emission Filter Holder/Retainer (Cat.# 
GM4017).

Unload 
Vessel

Moves the instrument stage forward to access the sample vessel. 
The stage will return to its previous position when the instrument lid is 
closed and the Unload Vessel button is selected again.

 
Help Opens the GloMax® Galaxy Bioluminescence Imager Operating 

Manual.
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3.2	 Exchanging the Excitation Module

Each of the GloMax® Galaxy excitation modules is recognized by the instrument when the 
module is installed. Select the EX button on the Galaxy® Control Software header to view the 
Excitation Module (Figure 16).

Figure 16. 
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Excitation configuration window.

To install a GloMax® Galaxy excitation module, align the electrical contacts on the module 
housing with the contact pad inside the module arm and push it down until it clicks into 
position (Figure 17).

Figure 17. 
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Installing an excitation module.

To remove a GloMax® Galaxy excitation module, make sure the module arm is locked, firmly 
grip the top of the LED module, and pull it up and out of the module arm. 
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3.3	 Changing the Emission Filter Configuration

1.	 The Glomax® Galaxy Imager should be on and connected before attempting to remove the 
filter slide. Select the EM button on the Galaxy® Control Software header to open the 
Emission Filter Configuration (Figure 15).

	 The filter slide position is displayed on the EM icon in the header. Opening the ‘Emission 
Configuration’ window automatically moves the filter slide to a safe position (Position 2) for 
removal.

	 Important: Attempting to remove the filter slide when it is at Position 1 or Position 4 may 
damage the slide and render the system inoperable. 

2.	 Remove the instrument lower front panel by gripping left and right edges and pulling it 
toward you (Figure 18, Panel A). The panel is held by magnets and will pull free. 

3.	 Identify the filter slide assembly mounted above the camera and completely loosen the 
four thumb screws that secure it (Figure 18, Panel B).

Figure 18. 
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C.

B.A.

Panel A. Removing the front panel. Panel B. Filter slide panel. Panel C. Removing emission filters.

4.	 Carefully pull the filter slide panel toward you. As it comes off the aligning posts, continue 
bringing it away from the instrument until the filter slide assembly is clear of the 
instrument. 

5.	 Emission filters can be removed from the filter slide by turning counterclockwise (Figure 18, 
Panel C).

5295MA.eps
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6.	 Thread the emission filter clockwise into an open position in the filter slide until finger tight. 
Note the emission filter positions printed on the filter slide (numbered 1–4, left to right, 
while facing the front of the instrument). Custom filters will need to be installed in a 
retainer and secured with a locking ring (Section 10, Related Products).

7.	 Reinstall the filter slide panel by carefully directing it into the instrument toward the aligning 
posts. Gently push it onto both posts until it stops, hold in place, and turn the thumbscrews 
until finger tight. 

8.	 Update the emission configuration by selecting the filter installed at each position from the 
drop-down menu (Figure 19, Panel A). If your filter is not listed, enter it on the ‘Custom 
Filters’ tab, which will add it to the drop-down list (Figure 19, Panel B).

9.	 Select OK to complete the emission filter update process.

Figure 19. 
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Panel A. Emission filter ‘Configuration’ tab. Panel B. Emission filter ‘Custom Filters’ tab.
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3.4	 Creating Capture Channels

Capture Channels are added and configured on the ‘Imaging’ tab during an active Imaging 
Session by selecting the + in the capture channels list (Figure 10). Options include 
Luminescence, Fluorescence and Brightfield. 

Capture channels will be captured in the order displayed on the ‘Imaging’ tab (top to bottom; 
Figure 20, Panel A). To change the order, select the ... button at the right of the capture channel. 
Select the options Move Up, Move Down, Move to Top, Move to Bottom, and Delete to edit the 
capture channels list (Figure 20, Panel B).

The blue-highlighted channel indicates the active channel in the live-view window. Select a 
different channel to view that channel.

There is a check box at the left of each capture channel in the list. Only the capture channels 
that are checked will be imaged during a Capture or Time-Series.

If the check box to the left of any capture channel shows an exclamation point [!], the channel 
is disabled due to mismatch with the current excitation or emission configuration. Check that 
the correct excitation module is installed and emission filter configuration. Disabled capture 
channels will be enabled when the instrument configuration is updated to match the channel 
settings.

Figure 20. 
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Panel A. Capture channels list. Panel B. Capture channel order options. 
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3.4.1	 Brightfield Capture Channel Settings
The capture channel settings for brightfield imaging include LED Power (%), Exposure (time) 
and Emission (Figure 21).

•	 Excitation percent power may be adjusted by dragging the slider, entering a value, or 
directly selecting the values (20, 30, 40, etc.) on the power scale.

•	 Exposure times for brightfield imaging will depend on your selected LED module and LED 
Power settings but will typically range from about 10–200 microseconds. 

	 Note: The LED will turn on for captures when the power (%) is set between 20–100%, even 
if live view is stopped or the LED is disabled. Use the “Disable LED” check box near the 
bottom of the right panel to keep the LED off, if desired, while editing capture channels or 
viewing luminescence in Live View on the ‘Imaging’ screen.

•	 The Emission selection box enables selection from a list of the installed filters. The 
emission filter selection will automatically default to “[Empty]” for Brightfield, but any 
installed emission filter may be selected. 

Figure 21. 
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Brightfield capture channel settings.
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3.4.2	 Luminescence Capture Channel Settings 
For luminescence, the capture channel settings include Exposure (time), Emission (Filter) and 
Binning (Figure 22). 

•	 Imaging unfiltered luminescence will maximize sensitivity for NanoLuc®-tagged targets of 
interest. Filters are included with the system for imaging NanoBRET® applications 
including protein:protein interactions and target engagement:

Emission Filter Luminescence Application

460nm/50BP BRET (Donor signal)

600LP BRET (Acceptor signal: HaloTag® NanoBRET® 618 Ligand)

•	 Exposure times for luminescence will depend on NanoLuc® luciferase expression levels 
and may range from a few seconds to several minutes to reliably image the sample. The 
GloMax® Galaxy Imager supports a maximum exposure of 60 minutes (3,600 seconds) for 
luminescence capture channels.

•	 Binning includes selections for None, 2x2 or 4x4, and applies only to the Live View image 
shown on the ‘Imaging’ screen when the channel is active. All captured images will be 
saved at full resolution independent of this setting. Binning combines the signal for each 
2 × 2 or 4 × 4 square section of pixels, reducing the resolution while increasing sensitivity. 
When binning is selected, the live view exposure time is reduced by four- or 16-fold, 
respectively. The faster live-view refresh rate may enable more efficient user optimization 
of focus and exposure of samples expressing low levels of NanoLuc. For example, a 
1-minute exposure with 4x4 binning selected will refresh the image in the live-view window 
approximately every 3.75 seconds. When captured, however, a full resolution image 
exposed for 1 minute will be saved. 
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Figure 22. 
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Luminescence capture channel settings.
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3.4.3	 Fluorescence Capture Channel Settings 
For fluorescence, the capture channel settings include LED Power (%), Exposure (time) and 
Emission (Filter; Figure 23). The Excitation is set to the module installed in the instrument when 
the capture channel is added. To add a capture channel for a different excitation module, install 
that module first.

•	 Excitation Power may be adjusted by dragging the slider, entering a value, or directly 
selecting the values (20, 30, 40, etc.) on the power scale.

•	 Exposure times for fluorescence will depend on your target and LED Power (%) settings but 
will typically range from several hundred milliseconds to several seconds. The GloMax® 
Galaxy Imager supports exposures up to 120 seconds for fluorescence capture channels.

	 Note: The LED will turn on for captures when the Power (%) is set from 20–100%, even if 
live view is stopped or the LED is disabled. Use the “Disable LED” check box near the 
bottom of the right panel to keep the LED off, if desired, while editing capture channels or 
viewing luminescence in Live View on the ‘Imaging’ screen.

•	 The Emission selection box enables selection from a list of the installed filters. The 
emission filter selection will automatically default to the filter selection matching the 
installed excitation module as listed in Table 1, but users may select any installed filter. 

Table 1. GloMax® Galaxy Excitation Module and Emission Filter Pairings for Common Fluorescent 
Targets.

Excitation Module Default Emission Filter Common Fluorescent Targets

UV (Excitation: 375/20nm) 460nm/50BP* DAPI, Hoechst, Blue fluorescent 
protein (BFP)

Blue (Excitation: 480/30nm)* 535nm/40BP* Green fluorescent protein (GFP), 
Alexa Fluor 488, FITC, SYBR

Green (Excitation: 540/25nm) 605nm/55BP Cy3, Janelia Fluor 549, DsRed, 
Alexa Fluor 555, MitoTracker™ 

Orange

Green (Excitation: 560/40nm) 600LP* Texas Red, Alexa Fluor 568, Alexa 
Fluor 594, MitoTracker™ Red, 

mCherry, Cy3.5

Amber (Excitation: 620/60nm) 700nm/75BP Cy5, Janelia Fluor 646

*Included with the GloMax® Galaxy Imager.
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Figure 23. 
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Fluorescence capture channel settings.
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3.5	 Saving Capture Channels

1.	 New user protocols may be created and saved within an imaging session. To create a new 
protocol, define the desired capture channels, select  on the right of the Capture 
Channels header, and select Save. 

2.	 You will be prompted to name the protocol. You also can provide a protocol tag. This text 
entry may be used to filter the saved protocols list later (Figure 24). 

Figure 24. 
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Save Protocol name prompt from the GloMax® Galaxy software.

3.	 To save the new protocol, select Save.
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3.6	 Other ‘Imaging’ Screen Features 

3.6.1	 Live-View Image
The center panel of the ‘Imaging’ screen displays a real-time image of the current field of view 
using the active capture channel settings when Live View image acquisition is active. The 
active live-view image updates regularly based on the exposure setting of the active capture 
channel. A blue dot at the bottom of the live-view image will flash as the camera acquires 
images.

Right-clicking on the live-view image provides options to:

•	 Save the live-view image. 

•	 Access the live-view display options where you can show or hide the scale bar and invert 
its color (black/white).

3.6.2	 Histograms
A histogram of the live-view image is displayed at the upper left corner of the ‘Imaging’ screen 
(Figure 25).

Figure 25. 
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Live-view image histogram.

The histogram x axis adjusts to the minimum and maximum pixel gray value present within the 
image. The marker positions, shown as white triangles, indicate the gray value settings used 
for display of the adjusted image. The gray values for the marker positions are noted at the 
upper right corner of the histogram graph. 
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3.6.3	 Histogram Adjustments
•	 When the Auto button at the upper right corner is blue, the marker positions are 

automatically set. Automatic settings may not be effective for all samples and sample 
types, including small tissue samples or sparsely plated cells. 

•	 The markers may be moved manually by clicking and dragging them along the x axis, 
which will update the live-view image in real time. Clicking immediately left or right of a 
marker incrementally nudges the marker position step-by-step for finer adjustments.

•	 Adjusting either marker will toggle the Auto setting off and change the Auto button to gray. 
Automatic adjustment of the marker positions can be reactivated by selecting the Auto 
button.

3.6.4	 Bookmarks
Positions within the vessel may be bookmarked by right-clicking on the vessel diagram and 
selecting Create New Bookmark from the menu. Each bookmark may be given a custom 
name, and the XY and focus positions will be saved (Figure 26).

Figure 26. A
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dding bookmarks. Panel A. Right-click on the vessel diagram and select Create New Bookmark. Panel B. 
You can edit the bookmark name in the ‘Add Bookmark’ window.

The list of saved bookmarks is accessed by right-clicking the vessel diagram. Selecting a 
bookmark from the list will move the stage to the bookmarked position.

Bookmarked positions are only maintained for the duration of the active session and are 
cleared when the session is closed.
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3.6.5	 Disable LED
When checked, the “Disable LED” option turns off the LED module, preventing it from being 
turned on for active bright field or fluorescence capture channels. You may find this useful for 
limiting sample exposure to excitation light while configuring capture channels. The “Disable 
LED” option does not prevent the LED from being turned on during a Capture or Time Series.

3.6.6	 Capture
The Capture button initiates capture of selected (check box) capture channels. 

1.	 To start a new capture, select the Capture button at the lower right of the ‘Imaging’ screen.

2.	 The ‘Capture Settings’ window will appear (Figure 27).

Figure 27. 
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‘Capture Settings’ window.

3.	 Edit the Name field and add a comment, if desired. (The Comment field entry can be 
viewed in the Session report and image metadata.) The session ID shown was entered at 
the start of the session and cannot be edited. The File Path is the gallery folder specified in 
Preferences on the ‘Common Settings’ tab. The default folder location is C:\Users\Public\
Documents\GloMax Galaxy.
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4.	 During a capture, a pop-up window will show the elapsed and remaining capture time and 
will display images as they are captured. Select the tabs for different channels on the left 
side of the window to toggle and view the respective images (Figure 28). 

No other system features may be used during a Capture or Time Series. However, image files 
will be saved as they are captured and can be opened and viewed using Fiji. 

While a capture is in progress, the green LED light in the power button will blink, indicating that 
the system is actively acquiring images. 

When the capture is completed, select the Close button to return to the ‘Imaging’ screen.

Figure 28. 
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‘Capture’ pop-up window. 
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3.6.7	 Time Series
The Time Series function initiates a series of captures to be performed over a defined time 
frame.

1.	 To start a new time series capture during an imaging session, select the Time-Series 
button at the lower right of the ‘Imaging’ screen.

2.	 The ‘Capture Settings’ window for the time series will appear (Figure 29).

Figure 29. 
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Time-Series ‘Capture Settings’ window.

3.	 Edit the Name field and add to the Comment field, if desired. (The Comment field entry will 
be viewable in the Session report and image metadata.) The session ID was entered at the 
start of the session and cannot be edited. The File Path is set in Preferences on the 
‘Common Settings’ tab. 

4.	 Enter the Total Capture Time for the series of captures by using the arrows to adjust hours, 
minutes and seconds, or manually entering the desired values. 

5.	 Enter the Capture Interval for the series of captures. 

	 Note: The minimum interval will be pre-determined based on the capture channels 
programmed; entering a value less than this minimum will display a message indicating an 
invalid entry.

5.	 The capture number will be calculated and displayed. A capture will be made at the start of 
the time series and then at each capture interval entered until the total capture time for the 
series is reached. 

6.	 Select Start to begin the time series or Cancel to return to the Imaging screen.
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7.	 During a time series, a pop-up window will show the elapsed and remaining time and the 
images captured from the last timepoint. Select the tabs for different channels on the left 
side of the window to view the respective images (Figure 30). 

8.	 No other system features may be used during a capture or time series. However, image 
files will be saved as they are captured and may be opened and viewed as they are saved 
using Fiji. 

9.	 While a capture is in progress, the green LED light in the power button will blink, indicating 
that the system is actively acquiring images. 

10.	 When the capture is completed, close the window to return to the ‘Imaging’ screen.

Figure 30. 
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Time-series captures and progress bar.
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3.7	 ‘Review’ Screen

The ‘Review’ tab can be selected during an imaging session to review captured images  
(Figure 31). 

Figure 31. 
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Image session ‘Review’ screen. The ‘Review’ screen provides functions to view, adjust and overlay captured 
images.



46      GloMax® Galaxy Bioluminescence Imager | TM756 | 10/24

GloMax® Galaxy Control Software 

3.7.1	 ‘Review’ Screen Features
Images List

•	 Images captured during the current session will be listed in the left panel in the order they 
were acquired, with the most recent captures at the top.

•	 The folder icon at the right of each capture name is a link to the folder location where the 
image files are saved. Image files are saved as .tiff files. The folder location also contains a 
Report.txt file that summarizes the captures made during the imaging session, including 
the LED module, LED power setting, emission filter and exposure time used for each 
image.

Capture Channels List

•	 The capture channels for the selected capture (highlighted blue in Figure 31) will be listed 
on the right panel and may be individually viewed, assigned color and adjusted. Changes 
may be reverted using the Reset button, which resets all changes made during the review.

•	 When more than one capture channel is selected (checked), they are displayed together.

•	 A histogram is present and can be adjusted independently for each capture channel. (See 
Section 3.6.2 Histograms for additional details.)

•	 To assign a display color for a capture channel, left-click on the letter (Luminescence, 
Fluorescence or Brightfield channel) next to the channel description and select from the 
drop-down list.

Image View 

•	 The center panel displays the selected image. If multiple capture channels are checked, 
they will be displayed together.

•	 The image view has the option of displaying a Timestamp and Scale, which can be toggled 
on or off by selecting the Timestamp and Scale buttons above the image view. The Text 
Color button will toggle the color between white or black. 

•	 Digital Zoom control at the bottom right of the ‘Review’ screen allows up to 1,000% (10X) 
zoom on-screen with ability to select the portion of the image that is displayed. 
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3.8	 Protocols

Protocols consist of one or more capture channels that can be opened and used during an 
imaging session. When a protocol is opened during an imaging session, you can clear existing 
channels or append the capture channels list.

3.8.1	 Promega Protocols
Several protocols are preinstalled for specific Promega assays. Promega Protocols may be 
used to start a new imaging session but may not be overwritten or deleted.

3.8.2	 Viewing Protocols
Select Protocols from the ‘Home’ screen to access the list of protocols currently present in the 
software (Figure 32). 

Figure 32. 
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GloMax® Galaxy ‘Protocols’ screen.
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3.8.3	 Protocols Screen
Protocols are displayed in a table format with several columns of information. Select any of the 
column titles at the top of the screen to sort the list of protocols in increasing or decreasing 
order by that column’s contents. 

Protocols can be marked as favorites by selecting the star on the left side of the protocol entry. 

Favorite protocols are automatically shown at the top of the protocols list the next time you 
access the ‘Protocols’ screen and Promega Protocols drop-down menu. There is no limit to the 
number of protocols that may be selected as favorites.

Name The Name of the protocol.

Type Promega (preinstalled) or User (saved by users).

Tag Additional identifying information entered by a user.

Date The date and time that the protocol was created.

 Protocol marked as favorite.

 Select protocol to either export or delete it.

 Reverse protocol order.

Protocol Selection Check Box

When performing actions (e.g., Export or Delete), use the check box at the left of each protocol 
to select the protocol(s) to which the action will apply. The check box in the table header can be 
used to toggle all of the check boxes on or off for listed protocols.

3.8.4	 Filtering the Protocol List
Use the buttons at the middle-left side of the screen to filter the list of protocols by text. This 
keyword is searched within all fields. All protocols that contain the keyword in any field are 
displayed. 

Protocols can be filtered by channel by checking each channel type (luminescence, 
fluorescence or brightfield). Only protocols containing capture channels that are checked will 
be displayed.

Any combination of text and channel selection filters may be used. 

Select the Show All button to clear all filters.
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3.8.5	 Viewing Protocol Details
1.	 To view details of an existing protocol, from the ‘Protocols’ screen, select a single protocol 

of interest.

Note: If more than one protocol is selected, no details will be displayed.

2.	 The protocol details will appear in the panel on the right (Figure 33).

3.	 To start a new imaging session with the capture channels preloaded, select the Capture 
button below the protocol details on the right.

Figure 33. 
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Protocol details. After selecting a protocol, the capture channels can be viewed. Selecting the Capture 
button will initiate a new imaging session with the selected protocol preloaded. 

3.8.6	 Deleting Protocols
Only user-defined protocols may be removed from the GloMax® Galaxy Software.

1.	 Select one or more protocols to be removed from the software using the check boxes to 
the left of each protocol entry. When one or more user-defined protocols is selected, the 
Delete button becomes active.

2.	 Press the Delete button to remove all selected user protocols from the software. (Deleted 
protocols cannot be recovered unless they were previously exported.)
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3.8.7	 Exporting Protocols
User protocols may be shared between GloMax® Galaxy Imagers by exporting from one 
installation of the GloMax® Galaxy Software and imported onto others. Promega preinstalled 
protocols for NanoBRET and Nano-Glo cannot be exported, but they can be saved as a user 
protocol, which can then be exported.

1.	 Select one or more user protocols to be exported from the software using the check boxes 
to the left of each protocol entry. When one or more user-defined protocols is selected, the 
Export button becomes active. 

2.	 Press the Export button to export all selected user protocols from the software. A file 
browser is displayed (Figure 34). You can select the folder location where the exported 
protocol(s) will be saved. The current location is highlighted. Navigate to the desired folder 
location. Once a path has been defined, select the OK button to export the protocol(s) to 
the specified path, or select Cancel to return to the ‘Protocols’ screen without exporting.

Figure 34. 
19

19
2T

A

Export protocol ‘Browse for Folder’ window. When exporting protocol(s), select a folder location to save 
the exported protocol(s).

3.8.9	 Editing a User or Promega Protocol
1.	 Load the capture channels from an existing user or Promega protocol into a new imaging 

session. 

2.	 Add, remove, reorder or edit capture channel settings as desired.

3.	 Select  at the right of the Capture Channels header and select Save to overwrite an 
existing user protocol or Save As to create a new user protocol. For Promega protocols, 
choose Save As to save the protocol with a new name. 
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3.9	 ‘Sessions’ Screen

From the ‘Home’ screen, the Gallery button will open a table listing the previous imaging 
sessions saved on the system (Figure 35).

Figure 35. 
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GloMax® Galaxy gallery screen. Saved sessions may be viewed on the ‘Review’ screen, deleted or the 
folder location of the stored image files opened.

3.9.1	 Managing Saved Sessions
•	 Select a session ID from the list to open the session in the ‘Review’ screen to view captured 

images. (The ‘Imaging’ tab will be deactivated. To acquire more images, initiate a new 
imaging session.)

•	 Check the box to the left of a single session and select the Open Folder button to open the 
folder location of the image files and session report in Windows® Explorer.

3.9.2	 Data Management
Checking the box to the left of one or more sessions and selecting the Delete button will 
permanently delete all image files for the selected session from the system. 

Note: Once sessions are deleted, they cannot be retrieved. Ensure image files are saved or 
archived elsewhere prior to deleting them from the GloMax® software.
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3.10	 Settings

Selecting Settings from the ‘Home’ screen provides access to navigation and camera settings, 
specify where files are saved, export log files and view system information (Figure 36).

Figure 36. 
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‘Settings’ screen.

3.10.1	 System Info Button
Selecting the System Info button will display system details including the Software Version 
and Build, Instrument Name and Serial Number, Firmware Version, Camera Serial Number and 
Firmware Version (Figure 37).

Figure 37. 

19
19

5T
A

GloMax® Galaxy system information window.
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3.10.2	 Export Logs Button
The software records all actions performed by the instrument. If there are error messages, 
export the log and contact Promega Technical Services (techserv@promega.com) for further 
instructions. The log file is useful for troubleshooting events.

After selecting the Export Logs button, a ‘Browser For Folder’ window opens and you can 
select the location at which logs will be exported (Figure 38). Navigate to the folder location 
where logs should be exported. Once you have selected the desired path, select the OK button 
to export log files. 

Figure 38. 
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Export logs ‘Browse For Folder’ window. Select a folder to which logs will be exported. Choose OK to 
export log files.

3.10.3	 Tools Button
Selecting Tools displays the button that prepares the instrument for shipment. Choosing this 
button will home the Z-stage and move the XY-stage into position for securing the shipping 
anchors (Figure 39). If additional adjustment is necessary, the knobs located at the right- and 
left-rear of the stage may be rotated to manually adjust the stage position. An image of the XY-
Stage secured with red shipping anchors is shown in Figure 4, Panel A.

Figure 39. 
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Tools button.



54      GloMax® Galaxy Bioluminescence Imager | TM756 | 10/24

GloMax® Galaxy Control Software 

3.10.4	 Administrator Button
The Administrator button is only displayed in the GloMax® Galaxy software when users 
with Administrator-level access view the ‘Settings’ screen. By default, all users will have 
Administrator-level access when the software is installed. To limit administrator-level access, 
the GloMax® software uses a Windows® login user access as a security tool. See Section 5.1, 
Assigning User Accounts to Promega Groups.

3.11	 Administrator Settings

Administrator settings are only available to users with administrator-level access to the 
GloMax® software. These settings allow the administrator to set software preferences, view 
and create vessel definitions, update GloMax® Galaxy Imager firmware, and access software 
Audit Records. To access administrator settings:

1.	 From the ‘Home’ screen, select the Settings button.

2.	 On the ‘Settings’ screen, select the Administrator button to open the ‘Administrator’ screen 
(Figure 40). 

Figure 40. 
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‘Administrator’ screen.
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3.11.1	 Audit Records Button
Administrators can view a chronological sequence of actions performed with the GloMax® 
Galaxy Imager by selecting the Audit Records button within the ‘Administrator’ screen. An 
example ‘Audit Records’ screen is show in Figure 41. Detailed audit records are automatically 
generated and stored with the GloMax® Galaxy software and cannot be deleted or edited.

Records may be exported by selecting the Export Records button on the upper left corner of 
the screen.

Figure 41. 
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‘Audit Records’ screen.

3.11.2	 Update Firmware Button
The ‘Update Firmware’ screen allows administrators to apply firmware updates received from 
Promega to the system. 



56      GloMax® Galaxy Bioluminescence Imager | TM756 | 10/24

GloMax® Galaxy Control Software 

3.11.3	 Vessels Button
The GloMax® Galaxy software uses stored vessel definitions to enable XY-stage and Z-(Focus) 
navigation during an imaging session. Supported vessel types are listed in Table 2.

Table 2. List of Recommended Sample Vessels.

Vessel Type Manufacturer Cat.# Dimensions Stage Adapter

8-well chamber slide 
(glass-bottom)

Promega 
IBIDI

GM4061 
(80807 IBIDI)

75.4 × 25.6 × 10.8mm (h) Slide Adapter

Slide (75mm × 25mm) (various) N/A 75 × 25mm Slide Adapter

35mm Petri dish 
(µ-DISH, optical plastic-
bottom)

IBIDI 81218 34.7mm (dia) × 11.7mm (h) 35mm Dish 
Adapter

96-well microplate 
(CELLView, glass 
bottom)

Greiner 655981 85.6 × 127.8 × 17.4mm (h) 96-Well Plate 
Adapter

24-well microplate 
(SensoPlate, glass-
bottom)

Greiner 662892 85.6 x 127.8 mm × 21.8mm (h) 96-Well Plate 
Adapter

12-well microplate 
(glass-bottom)

CELLVIS P12-1.5H-N 85.4 x 127.4 × 22.4mm (h) 96-Well Plate 
Adapter

6-well microplate (glass-
bottom)

CELLVIS P06-1.5H-N 85.4 x 127.4 × 21.9mm (h) 96-Well Plate 
Adapter

h = height; dia = diameter

Except for slides, all recommended vessels have 0.17mm glass bottoms for optimal sample 
imaging. Glass slides are suitable for imaging fixed samples, and you will obtain optimal image 
quality using 0.17mm cover glass mounted over the sample and the slide inverted on the stage 
with the cover glass and sample facing the objective. 

3.11.4	 Vessel Default Imaging Position
Vessels other than those listed in Table 2 may be suitable for use on the GloMax® Galaxy 
Imager but may require adjusting the default imaging position. This is the position that the 
objective moves to at the start of a new imaging session. If this position is incorrect, the 
objective may hit the bottom of the vessel or you may have difficulty finding the sample 
imaging plane.

Note: If using the Stagetop Incubator and Controller, GloMax® Galaxy (Cat.# GM4010), the 
focusing steps in Section 3.11.5 should be performed with the stagetop chamber installed.
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3.11.5	 Evaluating an Alternative Vessel and Setting the Focus Distance
1.	 Start a new imaging session and select the vessel type that matches the format of your 

desired vessel. 

2.	 Install the proper adapter on the stage, but do not load the vessel at this point.

3.	 Select OK to start the new session. The xy-stage and objective will move to the initial 
imaging position for the vessel type that was selected.

4.	 Open the instrument lid, unlock the LED arm and rotate the LED up away from the stage. 

5.	 Carefully position the desired vessel in the adapter, using one of the two options below:

	 If the bottom of the vessel contacts the objective lens, decrease the focus distance as 
follows: 

a.	 Remove the vessel, lower the LED arm, close the lid, and use the coarse z focus down 
button to lower the objective. 

b.	 Lower the objective in 1–2mm increments using the coarse z-focus adjustment.

c.	 Insert the vessel. Check if the vessel contacts the objective. If yes, repeat Steps a–c. If 
not, continue to Step d.

d.	 Focus on the imaging surface in brightfield; cells or a line drawn with a marker in 
well A1 are useful for finding the proper imaging plane.

d.	 When the sample is in focus, note the z position displayed under the vessel diagram. 
This value will be used in Step 8.

If the bottom of the vessel does not contact the objective lens:

a.	 Secure the Vessel, lower the LED arm and close the instrument lid.

b.	 Use the z-focus adjustment buttons to focus on the imaging surface in brightfield. 
Cells or a line drawn with a marker in well A1 are useful for finding the proper imaging 
plane.

c.	 When the sample is in focus, note the z position displayed under the vessel diagram. 
This value will be used in Step 8.

6.	 After the focus position is determined, close the imaging session, and navigate to  
Settings → Administrator → Vessels to display the table of vessel types saved in the 
software.

7.	 Select the vessel type that matches the format of your desired vessel and select the Create 
From button at the upper left of the screen.

8.	 Enter a name for the new vessel and set the Focus Distance (mm) to the z position 
identified in Step 5. Include the vendor and catalog number for the new vessel.

9.	 Select Save to add the new vessel to the database.

10.	 Return to the ‘Home’ Screen and initiate a new imaging session by selecting Capture. 
Select the new vessel type and start the session.

11.	 Verify that the initial focus distance brings the imaging surface of the vessel into view 
without substantially adjusting the z height. 
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3.11.6	 Preferences
The ‘Preferences’ screen is where administrators can specify the gallery folder location, 
set a limit for the number of capture channels that may be defined within a session, define 
camera crop width and height, define coarse and fine stage motion distances, and update the 
instrument name. The settings present on each tab on the ‘Preferences’ screen are described 
below.

‘Common Settings’ Tab

On the ‘Common Settings’ tab (Figure 42), an administrator can change the Capture Channels 
Limit and define the Gallery Folder location where image files are saved on the PC. 

Note: While a network drive may be selected for saving image files, if your network is not 
reliable or communication slows, there may be data loss.

Figure 42. 
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‘Preferences’ screen showing the ‘Common Settings’ tab.

‘Camera Settings’ Tab

On the ‘Camera Settings’ tab, an administrator can adjust the crop width and crop height (in 
pixels) for saved images. The default crop size is 2,200 × 2,200 pixels. The maximum crop 
width setting is 3,200 pixels. The maximum crop height setting is 2,200 pixels. 

Note: If the crop width and crop height are set significantly smaller than 2,200 pixels, consider 
adjusting the XY coarse and fine motion settings on the ‘Calibration’ tab to better match the 
smaller field of view. 
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‘Calibration’ Tab

On the ‘Calibration’ tab (Figure 43), an administrator can adjust coarse and fine motion 
distances for the XY-stage and for focus (Z). In addition to coarse and fine distances, an 
extra fine distance is also defined for focus (Z). The minimum setting for Z extra fine is 
0.0003125mm, which will provide optimal focus adjustment for fixed samples. Separate focus 
settings are provided for Live Cell and Fixed Cell imaging. 

Figure 43. 
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’Preferences’ screen showing the ‘Calibration’ tab.

Changes to Common Settings, Camera Settings and Calibration will automatically be saved 
when the user navigates away from the ‘Preferences’ screen. Select the Restore Defaults button 
at the lower left of the ‘Preferences’ screen to restore default settings for the displayed tab. 
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‘Instrument Name’ Tab

Enter the desired name of the instrument. This feature is typically used if a laboratory has more 
than one GloMax® Galaxy Imager. After changing the name, select the Update button to save 
the change. The instrument name will be noted in the image file metadata and the session 
report (Figure 44).

Figure 44. 
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‘Preferences’ screen showing the ‘Instrument Name’ tab.

Select the Restore Defaults button at the lower left of the ‘Preferences’ screen to restore 
default settings for the displayed tab. 
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Cleaning and Maintenance

4.1	 General Imager Care

Turn off the GloMax® Galaxy Imager and disconnect the AC power adapter whenever the 
interior of the instrument is open for cleaning and maintenance.

Residue from reagent spills can inhibit proper stage movement. Immediately clean up any 
spills. We recommend thoroughly cleaning the interior of the instrument every 30 days as 
follows:

Clean the stage using a Kimwipes® tissue dampened with 70% ethanol. Do not allow excess 
solution to run off onto other electrical components, because this can cause damage to the 
instrument and its electronics. Do not use solvents or abrasive cleaners.

Use a cloth dampened with deionized water to periodically clean the exterior of the GloMax® 
Galaxy Imager. Do not use solvents or abrasive cleaners.
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4.2	 Cleaning Imager Optics

Always wear new gloves when handling or cleaning optical components. Once your gloves are 
on, cleaning with an alcohol wipe will remove any trace contaminants that may be present on 
them. Avoid touching your hair, face or any uncleaned surfaces when handling optics.

4.2.1	 Cleaning the Objective
•	 Dust, fingerprints or other contaminants on the objective lens can adversely affect image 

quality. To ensure maximum performance of the GloMax® Galaxy Imager, we recommend 
regular cleaning of the objective.

•	 To access the objective for cleaning, navigate to Settings and then to Tools. Select the 
button, Prepare for Shipment. This will center the objective in the stage. Temporarily 
remove the stage top incubator, if installed.

•	 Use the provided air bulb to remove dust or other particulates from the objective lens. A 
lens-cleaning brush or other soft brush can be used to remove any remaining dust.

•	 Fingerprints or grease should be removed using lens cleaning paper or a soft cotton cloth 
soaked in absolute ethanol. The lens should be wiped in a circular motion from center to 
edge. A cleaning stick wrapped in lens paper can be used to clean harder-to-reach edges of 
the objective or tube lens.

•	 The objective lens is an air (dry) objective and should never be used with immersion oil. If 
this happens, lens cleaning paper soaked in petroleum benzine is recommended for 
cleaning off the oil, followed by ethanol as above.

4.2.2	 Cleaning the Emission Filters
Optical filters are delicate and must be handled with care. Always handle filters by the edges 
and place them on clean, soft surfaces if you need to set them down.

Routine cleaning is not recommended. If the emission filters look clean, do not clean them. 
Unnecessary cleaning can introduce contaminants or cause performance degradation.

If a filter needs to be cleaned, start by using the provided air bulb to remove any loose dust or 
debris.

Wiping should only be performed if necessary. If required, gently wipe the surface using 
a lint-free wipe or swab wetted with anhydrous reagent-grade alcohol or acetone. Avoid 
oversaturating the wipe or swab. Use a slow and steady drag across the surface, applying 
minimal force.
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5	�  
Troubleshooting

For questions not addressed here, contact your local Promega Branch Office or Distributor.  
Contact information available at: www.promega.com. Email: techserv@promega.com

5.1	 Error Messages

Error Message Description Resolution

Instrument Disconnected Instrument is not on. Turn on instrument, indicated by 
the green LED on/off button

Failed to connect: USB 
communication failure, 
device turned off or 
disconnected?

The software has failed to 
connect to and communicate 

with the instrument.

Check that the instrument is 
powered on and connected 
to the computer via the USB 
cable. Select the message at 

the bottom right of the software 
screen ”Instrument Offline – 
Click to Connect”. If the error 

persists, contact Promega 
Technical Services.

Failed to connect: Could 
not detect or initialize 
camera.

The software has failed to 
connect to and initialize the 

camera.

Remove the front panel to 
check that the camera power 

cable is connected and that the 
camera is on. Confirm that the 

camera communication cable is 
securely connected.

Camera not detected. 
Check power and USB 
connection to camera and 
try again.

Camera failure. Please 
restart the instrument.
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Error Message Description Resolution

Axis X not initialized. The stage is obstructed and 
unable to initialize.

Ensure the shipping anchors 
have been removed.  Check for 

other obstructions that may 
prevent the stage from moving.

Instrument not 
connected. Reconnect 
and try again.

The instrument-to-PC 
connection has failed.

Check that the instrument-to-
PC cable is securely connected. 
Make sure the cable is minimum 

USB 3.1 and has not been 
damaged. Confirm that the PC 
USB port is working properly. 

Failed to [camera 
command]. Camera error 
detected. Please restart 
the instrument.

The connected camera failed 
to respond to a command.

Check connections to camera. 
Restart the instrument by 
powering it off then back 

on. Reconnect to the control 
software by selecting 

Instrument Offline-Click to 
Connect at the bottom right of 

the control software screen.

Initialization failed on 
startup due to the lid 
being open. Close the lid 
and reconnect.

The lid was open during 
initialization

Close the instrument lid. 
Reconnect by selecting 

Instrument Offline-Click to 
Connect at the bottom right of 

the control software screen.

Filter slide 
communication error: 
Please reinstall the filter 
slide panel and press 
Retry

The system has failed to 
communicate with the filter 

slide.

Check that the filter slide 
panel is installed. Remove and 

reinstall the filter slide panel 
and secure using all four thumb 

screws.

Filter slide timeout. 
Reinstall filter slide panel 
and secure thumbscrews

Failed to capture image: 
Failed to move slide: 
Missing or invalid filter 
slide reply received

The system has failed to 
communicate with the filter 

slide.

Check that the filter slide 
panel is installed. Remove and 

reinstall the filter slide panel 
and secure using all four thumb 

screws.
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Error Message Description Resolution

Please make sure slide 
adapter is installed 

The system has failed to 
communicate with the filter 

slide.

Check that the filter slide 
panel is installed. Remove and 

reinstall the filter slide panel 
and secure using all four thumb 

screws.

Move aborted. Close the 
lid to initialize the stage.

The door of the instrument 
was opened during operation 
of the stage. This causes the 

stage motion to be halted. 

The system will reinitialize 
automatically when the door is 

closed and the error cleared.

Lens may make contact 
with vessel

The user attempted to adjust 
focus up with the objective 
near the edge of the stage 

adapter hardware.

For nonsupported vessels, 
check focal distance 

Cannot move beyond 
vessel envelope

The user attempted to 
navigate outside of the 

allowed range for the installed 
adapter and vessel.

Check the current XY-stage 
position in the vessel diagram 
to make sure you are not at or 

beyond the edge of the imaging 
surface. 

Cannot move stage: 
[ ]-axis out of range

The user attempted to 
navigate outside of the 

allowed range for the installed 
adapter and vessel.

Check the current XY-stage 
position in the vessel diagram 
to make sure you are not at or 

beyond the edge of the imaging 
surface.

Cannot move objective 
beyond adapter limit

The user attempted to adjust 
focus up with the objective 
near the edge of the stage 

adapter hardware.

Check the current XY-stage 
position in the vessel diagram 
to make sure you are not at or 

beyond the edge of the imaging 
surface. Navigate to the center 
of the vessel or a well and try 

again.

This instrument has not 
been calibrated.

The instrument does not have, 
or has lost, calibration values.

Call Promega Technical 
Services.

Lid Opened The door of the instrument 
door has been opened during 

the imaging session.

This message will appear during 
routine access of the stage 

and sample and will disappear 
automatically when the door is 

closed.
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Error Message Description Resolution

Please close the lid Appears when the instrument 
door has been opened. Closes 
automatically when the door 

is closed.

Not applicable.

Disk space is low, 
continue anyway?

Not enough space to save 
images

Need to create space on the C: 
drive for more images. 

Error Activating Brightfield Filter slide did not move Reinstall filter slide.

5.2	 Common Problems

Symptom Causes and Comments

Power failure during a run In the event of a power failure, turn off the instrument and 
PC. When power is resumed, turn on the instrument and 
PC. The results that were generated during the run before 
the power failure will be saved.
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Symptom Causes and Comments

Dim or low luminescence 
signal in images

Low luminescent signal or low activity in sample.

•	 �Increase exposure time. Due to the lower photon flux 
of luminescence compared to fluorescence, a longer 
exposure time is necessary to image luminescence. 
The length of exposure time will depend on the 
protein expression level. For reference, a GloMax® 
Discover System reader value of 1 × 105 may require 
a 3–5 minute exposure setting to acquire a suitable 
image using GloMax® Galaxy imager.

•	 Optimize treatment conditions
	    �If possible, use growth medium without phenol 

red and limit serum to 2% to minimize auto 
luminescence.

	    �When not using the Stagetop Incubator/Controller, 
use buffered medium (e.g., Opti-MEM) or CO2-
independent medium.

•	� Optimize transfection conditions. Avoid reverse 
transfection as it can result in poor cell adhesion. Plate 
cells at a density of 1 × 105 cells/ml and culture for 
24 hours before transfection.

•	� Try using an overexpressing NanoLuc® model system 
with high signal. Live-cell NanoLuc® substrates such as 
Vivazine™, Endurazine™ and Nano-Glo® Live Cell Assay 
System must follow the recommended assay collection 
durations. For example, the half-life of the Nano-Glo® 
Live Cell Assay is much shorter (approximatively 
5 minutes) compared to Vivazine™ or Endurazine™ 
substrates. Due to the extended exposure time needed 
for luminescence, image only a few samples at a time 
to maintain the assay signal half-life integrity.

•	� Collect a dark frame image and use it to subtract during 
imaging processing.

•	� If cell type requires a treated surface for a microplate 
reader assay, ensure the vessel used for imaging 
contains a similar treated surface. If using cells with 
low adhesion strength, apply a coating such as 0.1% 
gelatin to the imaging vessel surface.

•	� Using 2x2 or 4x4 binning can help increase signal 
intensity, thereby shortening the time necessary to 
determine the optimal z focus.
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Symptom Causes and Comments

Luminescence images out of 
focus or best focus is difficult 
to find.

Long capture times can make focusing on luminescence 
more challenging. Increase exposure, use 2x2 or 4x4 
binning, or incorporate a live-cell fluorescent stain, such as 
Hoechst 33342, and fluorescence capture channel to use 
for optimizing focus.

No image detected in 
brightfield.

•	 Check that the LED power is on (minimum 20%).

•	� Start live-view display. Check that the image is not 
saturated (reduce exposure and/or LED power).

•	 Check filter configuration in filter slide holder.

•	� Sample out of focus. Adjust focus. If using a vessel 
from a manufacturer other than those predefined in 
the software, refer to Section 3.11.5 to evaluate and set 
initial focus position.

Image detected in brightfield 
but not luminescence or BRET 

•	 Add Detection Substrate.

•	 �Check that the correct emission filters are installed 
in the filter slide and are correctly identified in the 
GloMax® Galaxy software.

•	 �Increase exposure time. Due to the lower photon flux 
of luminescence compared to fluorescence, a longer 
exposure time is necessary to image luminescence. 
The length of exposure time will depend on the 
protein expression level. For reference, a GloMax® 
Discover System reader value of 1 × 105 may require 
a 3–5 minute exposure setting to acquire a suitable 
image using GloMax® Galaxy imager.

•	 Optimize treatment conditions
	    �If possible, use growth medium without phenol red 

and limit serum to 2% to minimize autoluminescence.
	    �When not using the Stagetop Incubator/Controller, 

use buffered medium (e.g., Opti-MEM) or CO2-
independent medium.

•	� Optimize transfection conditions. Avoid reverse 
transfection as it can result in poor cell adhesion. Plate 
cells at a density of 1 × 105 cells/ml and culture for 
24 hours before transfection.

•	� Try using an overexpressing NanoLuc® model system 
with high signal.

•	� If using cells with low adhesion strength, apply a 
coating such as 0.1% gelatin to the imaging vessel 
surface.



69      GloMax® Galaxy Bioluminescence Imager | TM756 | 10/24

Troubleshooting

Symptom Causes and Comments

Image detected in brightfield 
but not fluorescence

•	 �Check emission filters installed in the filter slide are 
correctly identified in the GloMax® Galaxy software.

•	� Check that the excitation module is correct for the 
fluorescent target.

•	� Check that the LED power is on (minimum 20%). 
Increase LED power and/or exposure time.

•	� Light exposure can cause photobleaching of the 
fluorescent dye.

Difficulty finding sample and 
establishing initial focus

Use of nonsupported labware. See Section 3.11.4, Vessel 
Default Imaging Position.

No image displayed in live-view 
window

•	� Ensure live view is activated by selecting the Start 
button.

•	 �Ensure LED power (for brightfield and fluorescence) is 
set to a minimum value of 20% and that the “Disable 
LED” check box is unchecked.

•	� Adjust image histogram by manually moving the 
triangles or selecting the Auto button. 

•	� Adjust LED power and/or exposure to increase or 
decrease signal in the image. If all image pixels are 
saturated, the live-view window will be blank, and no 
histogram displayed. Decrease LED power and/or 
exposure to adjust intensity within the camera dynamic 
range.
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6	�  
Configuring the PC

The GloMax® Galaxy PC allows you to select from a series of options.

Your IT department or site administrator should configure the PC according to the IT rules 
and procedures pertinent to your institution. The following is a set of guidelines for your IT 
personnel or site administrator. Depending on your institution’s IT policy, you may or may 
not be able to configure or change the settings for the PC. You can install the full version of 
Microsoft® Office if you desire. We do not recommend loading other programs onto the PC 
because these may interfere with the instrument operation.

Note: Some institutions require antivirus software installed on PCs within the institution. If 
installing an antivirus program, ensure it is set to manual, not automatic, update. Antivirus 
software will slow the performance of the PC and affect the performance of the GloMax® 
Galaxy Imager while it is acquiring images.

Additional recommendations if using your own PC:

•	 Disable automatic Windows® updates and virus scans

•	 Disable automatic power off, sleep, or hibernation settings

•	 Disable “Fast Startup”. Set the power button to Shut Down not Sleep.

•	 Disable any other automatically or manually started software that would consume PC 
resources during operation.

•	 Ensure there are no domain policies that would overwrite any of the above settings.

Note: The PC that is provided with the GloMax® Galaxy Bioluminescence Imager System (Cat.# 
GM4000) has already been configured for the settings listed above.

The first time you use the GloMax® Galaxy Imager and PC, check the configuration of the 
following options. Settings can be changed later if required by following the instructions again.

1.	 Date and Time

	 The date and time set on the PC are used for the instrument run log to indicate when a 
protocol was run on the GloMax® Galaxy Imager, as well as during kinetic runs to mark the 
time during each read.

2.	 User Password and Setup

	 GloMax® software supports the following user roles.

	 PromegaAdministrator: Promega Administrators have access to all GloMax® Galaxy 
Control Software features needed to operate and manage the GloMax® Galaxy Imager.
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6.1	 Assigning User Accounts to Promega Groups

The GloMax® software employs the Windows® login user access levels as a security tool for 
adding approved users and associated passwords. New user accounts should be created 
based on policies governing your institution. Only someone with an Administrator account 
can assign users to Promega groups. You must close the GloMax® software to create user 
accounts.

1.	 Follow the instructions for your PC operating system.

2.	 If you want to add Administrators, select PromegaAdministrators. A 
‘PromegaAdministrator’ window will open, which can be used to add existing users to the 
PromegaAdministrators group. 

3.	 Select the Add… button to add users to the PromegaAdministrators group. In the “Enter the 
object names to select” area of the window, enter the username of the user you wish to 
add to this group. Select OK on this window and select OK on the ‘PromegaAdministrator 
Properties’ screen to add users to the PromegaAdministrators group. 

4.	 Close the ‘Computer Management’ screen.

6.2	 Removing User Accounts

The GloMax® Software employs the Windows® login user access levels as a security tool 
for adding approved users and associated passwords. Removing existing users can only be 
performed by someone with Administrator privileges.

1.	 Follow the instructions for your PC operating system.

2.	 Select Local Users and Groups and then choose Groups.

3.	 If you want to remove Administrators, select PromegaAdministrators. A 
‘PromegaAdministrator’ screen will open, which can be used to remove existing users from 
the PromegaAdministrators group.

4.	 Select the user you want to remove and select OK to remove selected user from the 
PromegaAdministrators group. Close the ‘Computer Management’ screen.
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7	�  
Warranty and Service

7.1	 Warranty

The GloMax® Galaxy Bioluminscence Imager comes with a one-year warranty from Promega. 
Additional warranty and service agreements are available. For more information, contact 
Promega Technical Services. Contact information is available at: www.promega.com.  
Email: techserv@promega.com

To obtain service during the warranty period, please take the following steps:

1.	 Contact Promega Technical Services.

2.	 Carry out minor adjustments or tests as suggested by your Technical Services contact.

3.	 If the instrument should be returned for repair, Promega Technical Services will arrange for 
service by an authorized GloMax® Service Agent. You will be issued a Promega return 
authorization number. You must obtain a Promega return authorization number (RMA 
number) before returning an instrument for service.

4.	 Before returning the instrument, you will be responsible for cleaning it and providing a 
Certificate of Decontamination (see Section 9). If the instrument has been exposed to any 
chemical, biological or radioactive hazards, contact Promega Technical Services for 
decontamination instructions before shipping.

7.2	 Warranty and Service Agreement Options

	 GloMax® Galaxy Premier Warranty Upgrade Cat.# SA1484
The Premier Warranty Upgrade includes all parts, labor and on-site service visits by a factory-
trained service technician within 3 business days (where available) during the first year of 
warranty. Additionally, it includes one annual on-site Preventive Maintenance visit by a service 
technician. Additional Preventive Maintenance visits are available separately.
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Warranty and Service

	 GloMax® Galaxy Premier Service Agreement
The Premier Service Agreement includes all parts, labor and on-site visits. The system will 
be repaired and returned to original factory specifications. A service technician will be on-
site within 3 business days for repairs. Additionally, it includes one annual on-site Preventive 
Maintenance visit by a service technician. Additional Preventive Maintenance visits are 
available separately.

Different options for the GloMax® Galaxy Premier Service Agreement are available as shown 
below. 

Product Name Cat.# 

GloMax® Galaxy Premier Service Agreement, 1 YR SA1511

GloMax® Galaxy Premier Service Agreement, 2 YR SA1521

GloMax® Galaxy Premier Service Agreement, 3 YR SA1531

	 GloMax® Galaxy Standard Service Agreement
The Standard Service Agreement covers all parts, labor and on-site visits. The system will be 
repaired and returned to original factory specifications. Additional Preventive Maintenance is 
available separately.

Different options for the GloMax® Galaxy Standard Service Agreement are available as shown 
below. 

Product Name Cat.# 

GloMax® Galaxy Standard Service Agreement, 1 YR SA1541

GloMax® Galaxy Standard Service Agreement, 2 YR SA1551

GloMax® Galaxy Standard Service Agreement, 3 YR SA1561

	 GloMax® Galaxy Preventative Maintenance Cat.# SA1488
To keep the system operating at peak performance, we recommend that GloMax® Galaxy 
Bioluminescence Imagers receive a Preventive Maintenance check at least every 12 months 
of use. During this procedure, our qualified service personnel test the instrument, check parts 
for wear and replace them as needed. Additionally, the system is aligned and functionality is 
verified. Documentation for your files is provided.
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Warranty and Service

	 GloMax® Galaxy Installation Qualification and Operational Qualification 

Product Name Cat.# 

GloMax® Galaxy Operational Qualification SA1501

GloMax® Galaxy Installation Qualification/Operational 
Qualification

SA1490

The Installation Qualification service product includes a series of formal instrument checks, 
delivers written documentation of instrument functionality, and demonstrates that everything 
ordered with the instrument is supplied and installed at the customer’s laboratory. This 
service product must be delivered by a Promega representative who is certified to perform the 
Installation Qualification. The service product involves a site visit to perform:

•	 Installation by qualified Promega personnel
•	 Inspection of shipping containers, instrument and accessories
•	 Comparison of items received vs. items on purchase order
•	 Inspection of laboratory conditions
•	 Review of all hazards and precautions with users
•	 Confirmation/installation of correct firmware version
•	 Testing of instrument run
•	 Recording and documenting installation and actions

The Operational Qualification service product demonstrates that the instrument functions 
according to its operational specifications. This service product must be delivered by a 
Promega representative who is certified to perform the Operational Qualification. The service 
product involves a site visit to perform:

•	 Running of operational verification tests
•	 Documenting of all calibration and test results 
•	 Training of customer(s) to operate the instrument
•	 Training of customer(s) to use the log book
•	 Completion of customer-specific log book, instrument sticker and OQ documentation
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	 Stagetop Incubator/Controller Standard Loaner Agreement
For customers who have also purchased the Stagetop Incubator/Controller for GloMax® Galaxy 
(Cat.# GM4010), Standard Loaner Agreements are available should your Stagetop Incubator/
Controller ever need service. 

Different options for the Stagetop Incubator/Controller Standard Loaner Agreement are 
available as shown below. 

Product Name Cat.# 

Stagetop Incubator/Controller Standard Loaner 
Agreement, 1 YR

SA1541

Stagetop Incubator/Controller Standard Loaner 
Agreement, 2 YR

SA1551

Stagetop Incubator/Controller Standard Loaner 
Agreement, 3 YR

SA1561
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8	� Viewing and Processing Images in FIJI 
(ImageJ)

Images collected on the GloMax® Galaxy Bioluminescence Imager are saved as .tiff files and 
therefore compatible with a variety of image analysis software. ImageJ is an open-source 
image processing and analysis program with vast functionality enabled by user-contributed 
plugins. FIJI is a distribution of ImageJ that provides convenient access to available plugins 
via an updater. More information about ImageJ and FIJI in addition to a comprehensive user 
guide is available here: https://imagej.net/learn/. Promega distributes Fiji Image Processing 
Software; it is preinstalled on the PC and included when purchasing Cat.# GM4000. Fiji ImageJ 
is installed on the included computer in C:/Users/Administrator/Fiji.app. When installed on a 
customer-provided PC, the application will be located in C:/Users/[username]/Fiji.app.

A few commonly used functions for general image visualization are below. Learn more at: 
www.promega.com/products/imaging-devices/glomax-galaxy-bioluminescence-imager/

Intensity adjustments: Image → Adjust → Brightness/Contrast

Applying a color scale or Lookup Table (LUT) Image → Lookup Tables

Merge channels into RGB image Image → Color → Merge Channels

Creating or manipulating image stacks Image → Stacks

Adding a scale bar to an image Analyze → Set Scale 

•	 Enter 1 in the Distance in pixels field.

•	� Enter 0.435 in the Known distance 
field.

•	 Enter µm in the Unit of length field.

•	� Check the box next to “Global” to apply 
to all opened images.

Analyze → Tools → Scale Bar

Pixel binning Image → Transform → Bin

For importing many images from a time series into a stack in chronological order, use File → 
Import → Image Sequence. This function indexes images in the session folder by defining 
the first image of the sequence (Start), the total number of images to import (Count), and the 
increment (Step). Select Browse to select the folder containing the time series images, and 
ensure the “Sort names numerically” box is checked. Selecting Use virtual stack will enable 
faster import if computer RAM is limiting.
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Viewing and Processing Images in FIJI (ImageJ)

8.1	 Background Subtraction and Dark Frame Collection

For luminescence images, you can perform a background subtraction to maximize image 
contrast, particularly for dim samples, which can also be useful for certain image quantitation. 
Background subtraction is best performed by collection of one or more dark frames using the 
same exposure settings as the sample, but with no sample in the instrument. Background pixel 
grey values are typically around 100 and can be subtracted from sample images in one of two 
ways:

1.	 If one dark frame is collected, calculate the mean of all pixel values in the image by 
selecting Analyze → Measure. With the sample image selected, go to Process → Math → 
Subtract, and enter this mean pixel value.

2.	 If multiple dark frames are collected, first create a stack (Image → Stacks → Images to 
Stack). Then generate an image of averaged pixel values by selecting Image → Stacks → Z 
Project, and choose Average Intensity from the drop-down menu. Use Process → Image 
Calculator to perform a pixel by pixel subtraction of the dark frame from the sample frame, 
and select 32-bit (float) if desired.
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9	�  
Certificate of Decontamination

Disinfection and decontamination are required prior to shipping the instrument and accessories 
for repair. Returned Instruments must be accompanied by a signed and dated Certificate of 
Decontamination, which must be attached to the accessories box inside the instrument packaging.

To disinfect and decontaminate: Wipe off the inside platform, and inside and outside surfaces 
using a cloth dampened with 70% ethanol. Follow immediately with a cloth dampened with 
deionized water. Repeat the procedure as many times as required to effectively disinfect and 
decontaminate the instrument.

Failure to follow these decontamination guidelines, sign and return the Decontamination Form 
will result in decontamination charges before the instrument will be serviced.

Select either (A) or (B):

	 A.	 �I confirm that the returned items have not been contaminated by body fluids or by 
toxic, carcinogenic, radioactive, or other hazardous materials.

	 B.	 �I confirm that the returned items have been decontaminated and can be handled 
without exposing personnel to health hazards.

Select the type of material used in the instrument: 	

	 Chemical Biological 

	 Radioactive**

Briefly describe the decontamination procedure performed:

Date:_ _________________________________________________________________________________________

Place:__________________________________________________________________________________________

Signature:_____________________________________________________________________________________

Name (block capital letters):_ __________________________________________________________________

** �The signature of a Radiation Safety Officer is also required if the instrument was used with 
radioactive materials.

This instrument is certified by the undersigned to be free of radioactive contamination.

Date:_ _________________________________________________________________________________________

Place:__________________________________________________________________________________________

Signature:_____________________________________________________________________________________

Name (block capital letters):_ __________________________________________________________________

Title:___________________________________________________________________________________________  
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10	� Repacking the GloMax® Galaxy  
Bioluminescence Imager

10.1	 Preparing the GloMax® Galaxy Imager

1.	 Position the stage by pressing the Prepare for Shipping button within the software 
(Settings).​

2.	 Turn off the instrument and decontaminate the instrument using 70% alcohol and soft 
cloth.​

3.	 Unplug the GloMax® Galaxy Imager and open the top lid.

4.	 Remove the excitation module (Figure 45, Panel A) and insert foam into position (Figure 45, 
Panel B).

Figure 45. 
19

23
4T

A

B.A.

Panel A. Removing the excitation module. Panel B. Adding foam. 
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Repacking the GloMax® Galaxy Bioluminescence Imager

5.	 Ensure the arm is in the Lock position. Insert the red and silver Packing Brackets into 
position (Figure 46). Use the red thumb screws to tighten the locking screws. Failure to 
complete this step will result in imager damage.

Figure 46. Lock the arm and fasten the packing brackets. 

19
23

5T
A

6.	 Disconnect AC Power Adapter on the back of the GloMax® Galaxy Imager.

7.	 Place the GloMax® Galaxy Imager inside the provided plastic bag.

10.2	 Packaging the PC and Accessories 

1.	 Power off the PC, then disconnect the USB and power cords from the PC.

2.	 Disconnect the USB and power cords from the monitor.

3.	 Pack the PC and keyboard into their shippingbox.

4.	 Pack the monitor into its box.
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Repacking the GloMax® Galaxy Bioluminescence Imager

10.3	 Packing the GloMax® Galaxy Imager Accessories

Please check to ensure all accessories are included. Pack the accessories into the white 
accessory box.

Figure 47. 

19
16
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A

Power cord for imager Excitation module Flat-tip screwdriver
1-Position Slide 

Holder Insert

AC power adapter USB cable
Side access panel 
with rubber insert

Hex wrench with 
extra screws 

Air bulb

Container with extra
stage adapter screws 

GloMax® Galaxy Imager accessory components.
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Repacking the GloMax® Galaxy Bioluminescence Imager

10.4	  Assemble the GloMax® Galaxy Imager Packaging

1.	 Place the instrument into the bottom layer of packaging foam. Assemble the packaging 
foam around the instrument (Figure 48, Panel A). 

2.	 Place the white accessory box onto the packaging foam. Insert the four corner supports 
(Figure 48, Panel B).

Figure 48. P

19
23
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B.A.

White 
accessory
box

Packaging
foam

Corner
supportPallet

anel A. Packaging the imager. Panel B. Adding accessory box and corner supports.

3.	 Replace the upper box sleeve to the imager box.

4.	 Add the imager and PC/monitor boxes onto the pallet and secure with the provided tether 
cords (Figure 49).

Figure 49. 
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PC and
monitor

Imager
Nylon shipping
straps

Securing the packaged imager, PC and monitor on the pallet.
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11	�  
Related Products

P R O D U C T  	 S I Z E  	 C AT. #

PC, keyboard and mouse, GloMax® Galaxy	 1 each	 GM4001

Monitor, GloMax® Galaxy	 1 each	 GM4002

Stagetop Incubator/Controller, GloMax® Galaxy	 1 each	 GM4010

Microplate Holder Insert, GloMax® Galaxy	 1 each	 GM4020

Petri Dish Holder Insert, GloMax® Galaxy	 1 each	 GM4021

1-Position Slide Holder Insert, GloMax® Galaxy	 1 each	 GM4022

UV 375/20nm Fluorescence Module, GloMax® Galaxy	 1 each	 GM4030

Green 540/25nm Fluorescence Module, GloMax® Galaxy	 1 each	 GM4034

Green 560/40nm Fluorescence Module, GloMax® Galaxy	 1 each	 GM4032

Amber 620/60nm Fluorescence Module, GloMax® Galaxy	 1 each	 GM4033

Blue 480/30nm Fluorescence Module, GloMax® Galaxy	 1 each	 GM4031

Filter, 460nm/50bp, 25mm, Galaxy	 1 each	 GM4011

Filter, 535nm/40bp, 25mm, Galaxy	 1 each	 GM4012

Filter, 635nm/60bp, 25mm, Galaxy	 1 each	 GM4013

Filter, 605nm/55bp, 25mm, Galaxy	 1 each	 GM4014

Filter, 700nm/75bp, 25mm, Galaxy	 1 each 	 GM4015

Filter, 600lp, 25mm	 1 each	 GM4016

Filter Holder with Retaining Ring, Empty	 1 each	 GM4017

Side Access Port with Rubber Insert	 1 each	 GM4018

8-Well Micro-Chamber Vessels	 15/pack	 GM4061

Custom emission filters for luminescence, BRET, FRET and fluorescence may be obtained from 
Semrock (www.semrock.com) or Chroma Technology Corporation (www.chroma.com). Filters 
must be a maximum of 5mm thick and have a diameter of 25mm. Consult the manufacturer’s 
documentation for filter orientation.

Note: Installing custom emission filters requires a separate emission Filter Holder with  
Retaining Ring (Cat.# GM4017), and Thorlabs Spanner Wrench for SM1-Threaded Retaining  
Rings (Thorlabs Cat.# SPW602). 

Contact Promega Technical Services (techserv@promega.com) to inquire about custom 
excitation modules.
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© 2024 Promega Corporation. All Rights Reserved.

GloMax, HaloTag, NanoBiT, NanoBRET, NanoLuc and Nano-Glo are registered trademarks of Promega Corporation.

Alexa Fluor is a registered trademark of Molecular Probes, Inc. Cy is a registered trademark of Global Life Sciences Solutions Germany GMBH. Excel and Windows are 
registered trademarks of Microsoft Corporation. Janelia Fluor is a registered trademark of Howard Hughes Medical Institute. Kimwipes are a registered trademark of 
Kimberly-Clark Corporation. MitoTracker is a trademark of Thermo Fisher Scientific. Opti-MEM is a registered trademark of Life Technologies Corporation. SYBR is a 
registered trademark of Molecular Probes, Inc.

Products may be covered by pending or issued patents or may have certain limitations. Please visit our website for more information.

All prices and specifications are subject to change without notice.

Product claims are subject to change. Please contact Promega Technical Services or access the Promega online catalog for the most up-to-date information on 
Promega products.
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